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SAM Office 2019 Project Notes for Windows and MacOS  
 

While most students will complete their SAM Projects using Office 2019 or 365 for Windows, 

we continue to make our SAM Office 2019 Projects as accessible to Mac users as possible. As 

of December 2019, SAM 2019 offers the following classifications of Projects: 

 

□ Not Mac-Compatible – These Projects cannot be completed on a Mac. 

o Note that all SAM Access Projects fall into this category, 

because Microsoft Access software is not available for the Mac 

OS. 

o Some textbook Projects cannot be fully completed on a Mac. 

Cengage textbooks are written to teach Office for Windows, 

which remains the most full-featured and most popular 

application in business today. If you only have a Mac, use the 

VDI network on campus to do assignments not Mac-

compatible. 

□ Mac-Compatible - Most SAM Projects fully support PC and MAC 

users by default.  

□ Mac Version Available –PC and Mac versions of some Projects are 

available. In these cases, instructor will edit the Project assignment 

options to enable OS detection for students completing the Projects 

on a Mac. The default option is PC only. Please refer to MAC Project 

differences below to learn more about these projects. 

 

The documentation that follows describes the differences that instructors and students will 

encounter with OS detection enabled for Projects with a Mac Version Available. 

 

To view the complete status of all Projects (Not Mac-Compatible, Mac-Compatible, or Mac 

Version Available), or to view known issues or other information, please refer to the Project 

and Task Information link on the SAM homepage. 

 

 

Contents 

 

Shelly Cashman Excel 2019 (CIS 111, Excel 1, & Excel 2) 3 

Shelly Cashman Excel 2019 | Module 4: SAM Project 1b 3 

Shelly Cashman Excel 2019 | Module 4: End of Module Project 2 3 

Shelly Cashman Excel 2019 | Module 5: End of Module Project 2 4 

Shelly Cashman Excel 2019 | Module 7: SAM Project 1a 4 

Shelly Cashman Excel 2019 | Module 7: SAM Project 1b 5 

Shelly Cashman Excel 2019 | Module 7: End of Module Project 1 7 

Shelly Cashman Excel 2019 | Module 7: End of Module Project 2 8 

Shelly Cashman Excel 2019 | Modules 4-7: SAM Capstone Project 1a 8 



 

2  

Shelly Cashman Excel 2019 | Module 8: SAM Project 1a 9 

Shelly Cashman Excel 2019 | Module 8: SAM Project 1b 10 

Shelly Cashman Excel 2019 | Module 8: End of Module Project 1 11 

Shelly Cashman Excel 2019 | Module 10: SAM Project 1a 12 

Shelly Cashman Excel 2019 | Module 10: SAM Project 1b 13 

Shelly Cashman Excel 2019 | Module 10: End of Module Project 1 14 

Shelly Cashman Excel 2019 | Module 10: End of Module Project 2 14 

Shelly Cashman Excel 2019 | Module 11: SAM Project 1a 15 

Shelly Cashman Excel 2019 | Module 11: SAM Project 1b 16 

Shelly Cashman Excel 2019 | Modules 8-11: SAM Capstone Project 1a 18 

 

Shelly Cashman Excel 2019 – Notes for Modules 4-7 for Excel 1 and for CIS 111: 

 

Shelly Cashman Excel 2019 | Module 4: SAM Project 1b 

Step Windows MacOS Notes 

1b For cell B7, edit the defined name to 

use Loan_Amt as the name. [Mac 

Hint: Delete the existing defined 

name "Loan_Am" and add the new 

defined name.] 

Mac 

hint 

added 

Delete the defined 

name first and 

then add the new 

defined name. 

Shelly Cashman Excel 2019 | Module 4: End of Module Project 2 

Step Windows MacOS Notes 

5 The cells in the range D3:D14 have 

defined names, but one could be clearer, 

another is unnecessary, and one is 

missing. Delete the Monthly_Contribution 

(cell D10) defined name because it will 

not be used in a calculation. [Mac Hint: 

Delete the existing defined name "Match" 

and add the new defined name.] Edit the 

name assigned to cell D6 to use 

Employer_Match as the defined name, 

which clarifies the contents of the cell. Use 

Future_Value as the name assigned to 

cell D14 so you can use the name in 

formulas. 

Mac 

hint 

added 

When the 

student edits 

the existing 

defined name 

in Mac, a new 

defined name 

appears but the 

old one must 

be manually 

removed. 



 

3  

10 Based on the range F3:N23, create a 

two-variable data table that uses the 

annual rate of return (cell D8) as the row 

input cell and the employee percent 

invested (cell D5) as the column input 

cell. 

[Mac Hint: To see the data properly, 

use AutoFit to change the column 

width of columns G through N.] 

Mac 

hint 

added 

The student is 

unable to see 

the data in the 

cells. 

 

Shelly Cashman Excel 2019 | Module 5: End of Module Project 2 

Step Windows MacOS Notes 

4 In the range A13:E16, Malai wants to 

include data about the types of posts the 

company makes on their website and social 

media webpages. This data is stored in a text 

file. 

Import the CSV file Support_EX19_EOM5-

2_Posts.csv as a table starting in cell A13 of 

the existing worksheet. [Mac Hint: Use 

column delimation while importing the .csv 

file.] 

Mac 

hint 

added 

The student 

must set the 

Comma 

delimiters 

option in 

the Text 

Import 

Wizard. 

 

Shelly Cashman Excel 2019 | Module 7: SAM Project 1a 

 

Step Windows MacOS Notes 

1a Apply the Turquoise, 

Accent 

Color 1, Shadow 

WordArt Style to the 

title. 

Apply the Fill: Turquoise, 

Accent Color 1; Shadow 

WordArt Style to the title. 

The color 

name 

differs in 

Mac. 
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2a, 

b 

a. Open the 

webpage 

Support_EX19_7a_Tea

m.html  in a browser. 

b. In the Asset 

Management 

worksheet, import the 

data from the 

Support_EX19_Team 

In cell B29, use the 

Quick Analysis tools to 

insert the total 

investment amount 

from the range 

B21:B28, which 

should match the total 

in cell D28. 

c. webpage in cell 

G12. 

a. From the Data tab, use 

the 'From HTML' tool to 

open the webpage 

Support_EX19_7a_Mac_Tea

m.html   as a table in a new 

workbook. 

b. Copy the table, with the 

column headers included, 

from the new worksheet. In 

the Asset Management 

worksheet, paste the table in 

cell G12. Close the new 

worksheet without saving. 

The 

instructi

ons were 

reworde

d 

because  

the 

process 

to 

import 

the data 

is 

different 

in Mac. 

14a a. Use the Quick 

Analysis tool to create 

a conditional 

formatting rule that 

adds Solid Fill Blue 

Data Bars to the range 

F21:F28 to help clients 

visualize the data. 

a. In cell B29, use the 

Sum function to insert the 

total investment amount from 

the range B21:B28, which 

should match the total in cell 

D28. 

b. Create a conditional 

formatting rule using the 

Solid Fill Blue Data Bar 

option to the range F21:F28 

to help clients visualize the 

data. 

The 

instructio

ns were 

reworded 

because  

the 

Quick 

Analysis 

tool is 

not 

available 

in Mac. 

16a In cell E30, insert a 

Callout: Line shape 

from the Callouts 

section of the Shapes 

gallery. 

In cell E30, insert a Line 

Callout 1 shape from the 

Callouts section of the 

Shapes gallery. 

The 

shape 

name 

differs 

in Mac. 
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Shelly Cashman Excel 2019 | Module 7: SAM Project 1b 

Step Windows MacOS Notes 

2a In the Reunion 

Organizers worksheet, 

get data from the 

Support_EX19_7b_Co

mmittees.ht ml 

webpage. (Hint: Use 

Windows Explorer to 

navigate to the 

Support_EX19_7b_Co

mmittees.ht ml 

webpage, click in the 

Address bar, and then 

copy the path. In the 

From Web dialog box, 

paste the path in the 

URL box.) Import only 

the 2022 Reunion 

Committee Members 

webpage data as a 

table to cell G12 in the 

existing worksheet. 

a. From the Data tab, use 

'From HTML' to open the 

Support_EX19_7b_Mac_Com

mittees.ht ml webpage as a 

table in a new workbook. 

b. Copy the table, with 

column headers included, 

from the new workbook. In 

the Reunion Organizers 

worksheet, paste the table in 

cell G12. Close the new 

workbook without saving. 

The 

instruction s 

were 

reworded 

because the 

process to 

import the 

data is 

different in 

Mac. 

 

 

14a, 

b 

a. In cell D27, use 

the Quick Analysis tools 

to insert the total 

number of registrations 

to date from the range 

D19:D26. (Hint: Ignore 

the errors if any appear.) 

b. Use the Quick 

Analysis tool to create a 

Conditional Formatting 

rule that adds Solid Fill 

Blue Data Bars to the 

range F19:F26 to help 

Clare visualize the data. 

a. In cell D27, use the 

Sum function to enter the 

total number of registrations 

to date from the range 

D19:D26. (Hint: Ignore the 

errors if any appear.) 

b. Create a Conditional 

Formatting rule that adds 

Solid Fill Blue Data Bar to 

the range F19:F26 to help 

Clare visualize the data. 

The 

instructions 

were 

reworded 

because the 

Quick 

Analysis 

tool is not 

available in 

Mac. 
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16a In cell B28, insert a 

Callout: Line shape 

from the Callouts 

section of the Shapes 

gallery. 

In cell B28, insert a Line 

Callout 1 shape from the 

Callouts section of the Shapes 

gallery. 

The shape 

name 

differs in 

Mac. 

 

Shelly Cashman Excel 2019 | Module 7: End of Module Project 1 

Step Windows MacOS Notes 

2 Abdul needs to import data from the New 

York, Chicago, and Los Angeles offices. The 

New York office provided its monthly data in 

a text file. Import the data from the file 

Support_EX19_EOM7-1_NewYork.csv as a 

table in the Advertising worksheet beginning 

in cell A10. 

Not Mac 

com-

patible 

The 

Power 

Query is 

not com-

patible 

with 

Mac. 

3 The Chicago office provided its monthly data 

as an Access database file. Select the 

Chicago table in Support_EX19_EOM7-

1_Chicago.accdb for importing. Use the 

Power Query Editor to transform the data by 

removing the first column, and then load the 

data as a table in the Advertising worksheet 

beginning in cell A16. 

Not Mac 

compati

ble 

The 

Power 

Query is 

not 

compati

ble with 

Mac. 

4 The Los Angeles office provided its monthly 

data as a webpage file. Import the data from 

the file Support_EX19_EOM7-

1_LosAngeles.html, specifying a path such 

as c:\users\username\documents\projects\ 

Support_EX19_EOM7-1_LosAngeles.html. 

Select the Wang Marketing: Los Angeles 

Office data. Use the Power Query Editor to 

transform the data by removing the first 

column, and then load the data as a table in 

the Advertising worksheet beginning in cell 

A22. 

Not Mac 

com-

patible 

The 

Power 

Query is 

not com-

patible 

with 

Mac. 
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Shelly Cashman Excel 2019 | Module 7: End of Module Project 2 

Step Windows MacOS Notes 

3 The worksheet should list information about the 

department members, which is contained in a 

webpage. Get data from the  

Support_EX19_EOM7-2_Department.html  

webpage. (Hint: Use Windows Explorer to 

navigate to the Support_EX19_EOM7-

2_Department.html webpage, click in the 

Address bar, and then copy the path. In the From 

Web dialog box, paste the path in the URL box.) 

Import only the Web Development Department 

Members webpage data as a table to cell G11 in 

the existing worksheet. 

Not 

Mac 

com-

patible 

Data cannot be 

imported in Mac. 

10 Resize columns A:E to their best fit, resize 

column G to 18.25, and resize column H to 

13.00. Hide rows 11 to 17 so that the worksheet 

does not display duplicated data. 

Not 

Mac 

com-

patible 

Only the width of 

18 or 18.33 

(instead of 18.25) 

can be applied in 

Mac. 

16 Go to the Resources worksheet, which Ruben 

asks you to finish. In cell D12, use the Quick 

Analysis tools to insert the total number of 

resources from the range D4:D11. (Hint: Ignore 

the errors if any appear.) 

Not 

Mac 

compat

ible 

The Quick 

Analysis tool is 

not available in 

Mac. 

 

Shelly Cashman Excel 2019 | Modules 4-7: SAM Capstone Project 1a 

Step Windows MacO

S 

Notes 

10a Use the Quick Analysis tool to create a 

Stacked Column chart that compares the 

revenue from each type of media for Quarters 

1–4 (range A5:E11). [MAC HINT: Select 

Stacked Column chart from Recommended 

Charts under the Insert tab.] 

Mac 

hint 

added 

The Quick 

Analysis 

tool is not 

available in 

Mac. 
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12c,d,

e 

a. a. In the Power Query Editor window, choose 

to close and load to a location in the 

worksheet. [MAC Hint: Use Text Import 

Wizard to import data as tab delimited text.] 

b. View the imported data as a table and 

insert the data in cell H5 of the existing 

worksheet. [MAC Hint: Import data as text 

and update the table name from "Table_2" to 

"Support_EX19_CS4_7a_Media".] 

c. Apply Blue, Table Style Medium 2 to 

the imported table to coordinate with the rest 

of the worksheet contents. [MAC Hint: 

Format as Table using Blue, Table Style 

Medium 2.] 

Mac 

hint 

added 

The 

Power 

Query 

Editor 

window 

does not 

appear in 

Mac. 

 

 

Notes for Excel 2, Modules 8-10: 

 

Shelly Cashman Excel 2019 | Module 8: SAM Project 1a 

Step Windows MacOS Notes 

4a Insert the Sum of Payment by State 

recommended PivotTable. [Mac Hint: Use 

the State field in the Rows area, the 

Payments field in the Values area, and show 

grand totals for rows and columns.] 

Mac 

hint 

added 

Fields need 

to be added  

manually in 

Mac. 
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Shelly Cashman Excel 2019 | Module 8: SAM Project 1b 

Step Windows MacOS Notes 

4a Insert the Sum of Billed by Location 

recommended PivotTable. [Mac Hint: 

Use the Location field in the Rows 

area and the Billed field in the Values 

area. Be sure to uncheck the Buyer ID 

and Item ID check boxes to deselect 

and remove them from the 

PivotTable, and drag the Location 

Field from the Columns area to the 

Rows area.] 

Mac 

hint 

added 

When the 

student adds the  

recommended 

PivotTable, "Item 

ID" and "Sum of 

Buyer ID" also 

display in the 

field list. 

5a,b,

c 

a. Insert a Combo PivotChart 

based on the Billed by Location 

PivotTable. [Mac Hint: Insert a 

Clustered Column Chart.] 

b. Display the Total Billed as a 

Clustered Column chart and the 

Average Billed as a Line chart. [Mac 

Hint: Select the "Average Billed" 

data series, select Change Chart 

Type on the Design tab, point to 

Combo, and then select Clustered 

Column - Line.] 

c. Include a secondary axis for the 

Average Billed data. [Mac Hint: 

Select the "Average Billed" data 

series/line, control+click the 

series/line, select Format Data Point, 

and then select the Secondary Axis 

radio button.] 

Mac 

hint 

added 

Options are not 

available to 

perform Steps 

5(a), 5(b), and 

5(c) in Mac. 
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Shelly Cashman Excel 2019 | Module 8: End of Module Project 1 

 

4 Sonia also wants to display the 

revenue by branch data as a chart. 

Insert a Combo PivotChart based on 

the new PivotTable. Display the 2020 

Revenue and the 2021 Revenue data 

as a Clustered Column chart and the 

Average 2020-2021 data as a Line 

chart. Include a secondary axis for the 

Average 2020-2021 data. 

Not Mac 

compatible 

The Sum of 

Revenue 

2021 by 

Branch (+) 

recommende

d PivotTable 

is not 

available in 

Mac. 

5 Display the legend at the bottom of 

the chart, and then hide the Field List 

and all the field buttons to remove 

clutter from the worksheet. Change 

the maximum bounds for the value 

axis on the left to 9,000,000. Change 

the PivotChart colors to 

Monochromatic Palette 4. Resize and 

position the PivotChart so that it 

covers the range A9:D24. 

Not Mac 

compatible 

The Sum of 

Revenue 

2021 by 

Branch (+) 

recommende

d PivotTable 

is not 

available in 

Mac. 

6 Add a slicer based on the Policy Type 

field, and then apply the Coral, Slicer 

Style Light 4. Display the slicer buttons 

in two columns, and then move and 

resize the slicer so that the upper-left 

corner is in cell E3 and the lower-right 

corner is in cell G8. Use the slicer to 

filter the PivotTable and PivotChart to 

display Auto, Home, and Life policies. 

Not Mac 

compatible 

The Sum of 

Revenue 

2021 by 

Branch (+) 

recommende

d PivotTable 

is not 

available in 

Mac. 
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10 Insert a PivotTable and PivotChart on a 

new worksheet, using Average 

Revenue as the worksheet name. Make 

sure the 'Add this data to the Data 

Model' checkbox is unchecked. With 

the blank PivotChart selected, add the 

Years Experience field to the Axis 

(Categories) area, Revenue 2020 as the 

first Values field, and Revenue 2021 as 

the second Values field. Change the 

value field settings of both value fields 

to display averages, using the Currency 

number format with 2 decimal places 

and the $ symbol. Change the 

PivotChart layout to Layout 3, and use 

Revenue by Years of Experience as 

the chart title. Move and resize the 

PivotChart so that its upper-left corner 

is in cell A9 and its lower-right corner is 

in cell C24. 

Not Mac 

compatible 

The 

PivotTable 

and 

PivotChart 

options are 

not available 

in Mac. 

 

Shelly Cashman Excel 2019 | Module 10: SAM Project 1a 

Step Windows MacOS Notes 

8g, h New step added to Mac 

project 

Remove all 

subtotals from the 

PivotTable. 

 

Format the Sum of 

ContractAmt field 

using the Currency 

number format with 

2 decimal places 

and the $ symbol. 

The instruction to 

remove subtotals 

was added. A step 

was added 

because the 

number format 

needs to be 

changed in Mac. 

9h New step added to Mac 

project 

h. Format the 

Sum of InvoiceAmt 

field using the 

Currency number 

format with 2 

decimal places and 

the $ symbol. 

Step 9(h) was 

added because 

the number 

format needs to 

be changed in 

Mac. 
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10 To properly combine 

data from the 

Customer, Contract, 

and Invoice tables, 

create relationships 

between tables as 

follows: 

a. In the Power 

Pivot for Excel 

window, create a 

relationship between 

the Customer and 

Contract tables using 

the CustomerID 

column to relate the 

tables. 

b. Create a 

relationship between the 

Contract and Invoice 

tables using the 

ContractNum column to 

relate the tables. 

Step removed. Power Pivot 

is not 

available in 

Mac. 

 

 

Shelly Cashman Excel 2019 | Module 10: SAM Project 1b 

Step Windows MacOS Notes 

8g New step added to Mac project Remove 

all 

subtotals 

from the 

PivotTabl

e. 

Step 8(g) was 

added to remove 

all subtotals. 

10 To properly combine data from 

the Client, Project, and Invoice 

tables, create relationships 

between tables as follows: 

a. In the Power Pivot for Excel 

window, create a relationship 

between the Client and Project 

tables using the ClientID column to 

relate the  tables. 

b. Create a relationship 

between the Project and Invoice 

tables using the ProjectNum 

column to relate the tables. 

Step 

removed 

Power Pivot is not 

available in Mac. 
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Shelly Cashman Excel 2019 | Module 10: End of Module Project 1 

Step Windows MacOS Notes 

1 Go to the Education and Age worksheet, 

where Pedro wants to include educational 

information about Wyoming counties. He has 

another workbook that already contains this 

data. Use Power Query to connect to and 

import data from the Support_EX19_EOM10-

1_Education.xlsx workbook. 

Transform the data in the Education table to 

remove the top two rows and the column 

containing state data. Use the first row as 

headers. Close and load the transformed 

data to a table in cell A2 of the existing 

worksheet. 

Not mac 

compatible 

The 

Power 

Query 

feature is 

not 

available 

in Mac. 

 

 

Shelly Cashman Excel 2019 | Module 10: End of Module Project 2 

Step Windows MacOS Notes 

1 Customize the theme fonts to use 

Arial as the heading font and Calisto 

MT as the body font. Customize the 

theme colors to use Dark Purple, 

Background 2 as the hyperlink color. 

Save the new settings as a custom 

theme, using Menlo as the theme 

name. 

Not mac 

compatible 

The 

Customize 

Fonts and 

Customize 

Color 

options are 

not available 

in Mac. 
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Shelly Cashman Excel 2019 | Module 11: SAM Project 1a 

Step Windows MacOS  Notes 

3 Lydia wants to customize 

the appearance of this 

workbook by changing a 

theme color and theme 

font. She also wants all 

new workbooks in the 

Sales and 

Marketing Department to 

reflect these changes. 

Create a custom theme as 

follows: 

a. Create a custom 

color scheme named eMD 

that uses Blue- Gray, 

Accent 2, Darker 50% as 

the Text/Background—

Dark 2 color. 

b. Create a custom font 

set name eMD that uses 

Century Schoolbook as the 

Heading font and Calibri 

Light as the Body font. 

c. Save the new 

settings as a custom 

theme using eMD as the 

name of the new theme. 

Step removed. The 

Customize 

Fonts and 

Customize 

Color 

options are 

not 

available in 

Mac. 

5/4 Use the Quick Analysis tool 

to add Line sparklines to the 

range G4:G8 to chart the 

Q1–Q4 values and totals 

(range C4:F8) for each type 

of product or service. (Hint: 

Select the Q1–Q4 values 

and totals first.) 

Add Line 

sparklines to the 

range G4:G8 to 

chart the Q1–Q4 

values and totals 

(range C4:F8) for 

each type of 

product or service. 

(Hint: Select the 

Q1–Q4 values and 

totals first.) 

The 

instructions 

were 

reworded 

because the 

Quick 

Analysis tool 

is not 

available in 

Mac. 



 

15  

15 Lydia is planning to send 

the workbook to the eMD 

sales representatives. 

Because not all of them 

have the latest version of 

Excel, she asks you to 

check the compatibility of 

the workbook. 

a. Check the 

compatibility of the 

workbook. 

b. Copy the 

Compatibility Report 

to a new worksheet. 

Step removed. The Check 

compatibility 

feature is 

not available 

in Mac. 

16b/14

b 

Mark the workbook as final. Change the 

workbook 

settings to 

always open 

read-only. 

The option to 

mark the 

workbook as 

final is not 

available in 

Mac. 

 

Shelly Cashman Excel 2019 | Module 11: SAM Project 1b 

Step Windows MacOS Notes 

3 Kenny wants to customize the 

appearance of this workbook by 

changing a theme color and 

theme font. He also wants all new 

Task Team workbooks to reflect 

these changes. Create a custom 

theme as follows: 

a. Create a custom color scheme 

named TaskTeam that uses Light 

Green in the Standard Colors 

palette as the Followed 

Hyperlink color. b.Create a 

custom font set name TaskTeam 

that uses Rockwell (not 

Rockwell Condensed) as the 

Heading font and Rockwell as the 

Body font. 

c. Save the new settings as a 

custom theme using TaskTeam 

as the name of the new theme. 

Step removed The 

Customize 

Fonts and 

Customize 

Color options 

are not 

available in 

Mac. 
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5/4 Use the Quick Analysis tool to add 

Line sparklines to the range 

F3:F7 to chart the Year 1 to Year 

4 values and totals (range B3:E7) 

for each category of service. (Hint: 

Select the Year 1 to Year 4 values 

and totals first.) 

Add Line 

sparklines to the 

range F3:F7 to 

chart the Year 1 to 

Year 4 values and 

totals (range 

B3:E7) for each 

category of 

service. (Hint: 

Select the Year 1 

to Year 4 values 

and totals 

first.) 

The instructions 

were  reworded 

because the 

Quick Analysis 

tool is not 

available in 

Mac. 

 
 
 
 
 
 
 
 
 
 

 

15 Kenny is planning to send the 

workbook to Task Team service 

representatives. 

Because not all of them have the 

latest version of Excel, he asks 

you to check the compatibility of 

the workbook. 

a. Check the compatibility 

of the workbook. 

b. Copy the Compatibility 

Report to a new worksheet. 

Step removed The Check 

Compatibility 

feature is not 

available in 

Mac. 

16b/ 

14b 

Mark the workbook as final. Change the 

workbook settings 

to always open 

read-only. 

The option to 

mark the 

workbook as 

final is not 

available in 

Mac. 
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Shelly Cashman Excel 2019 | Modules 8-11: SAM Capstone Project 1a 

Step Windows MacOS Notes 

15 Insert a recommended 

PivotTable based on the 

Orders table as follows: 

a. Insert the Sum of 

Payment by Region 

recommended PivotTable. 

b. Use May Sales by 

Region as the name of the 

new worksheet. 

Create a new 

PivotTable 

based on the 

Orders table 

as follows: 

a. Insert a 

PivotTable on 

a new 

worksheet 

using May 

Sales by 

Region as the 

name of the 

new worksheet. 

b. Display 

the Region 

field as row 

headings. 

c. Display 

the Payment 

field as the 

values. 

Step 15 was 

reworded 

because a 

recommended 

PivotTable is 

not available in 

Mac. 
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22 Eva also wants to create a 

PivotTable that includes data 

about sales representatives and 

their sales. She already added 

the tables containing this data to 

the Data Model. Eva wants to 

list each sales rep by name 

along with their region, number 

of products sold, and total 

amount of sales. Create a 

PivotTable that displays this 

information as follows: 

a. Use Power Pivot to 

create a PivotTable on a new 

worksheet, using Sales Reps 

as the name of the worksheet. 

b. Display the LastName 

field values from the Query – 

SalesReps data source as row 

headings. 

c. Display the Region field 

values from the Query – 

SalesReps data source as 

column headings. 

d. Add the TotalSales field 

from the Query - Sales data 

source to the Values area to 

sum the field values. 

Step removed Power Pivot 

is not 

available in 

Mac. 

23 To properly combine data from the 

Sales and SalesReps tables, use 

the Power Pivot for Excel window 

to create a relationship between 

the Sales and SalesReps tables 

using the SalesRepID column to 

relate the tables. 

Step removed Power Pivot 

is not 

available in 

Mac. 

 


